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OEW SITE STATISTICAL SAMPLING BASED METHODOLOGY
(SiteStats)
USEPR’S MANUAL

1.0 INTRODUCTION

The OEW Site Statistical Sampling Based Methodology (SiteStats) implements
the methodology developed by QuantiTech, Inc., for U.S. Army Engineer Division,
Huntsville, in support of the Division's role as the Ordnance and Explosive Waste (OEW)
Mandatory Center of Expertise (MCX). The tool is intended to assist the OEW MCX in
fully characterizing sites within given statistical bounds with minimal sampling.
Additionally, SiteStats provides the Remediation Planning Tool which can be used to
determine how remediation can best be performed, given a specified level of work, a

specified dollar level, or a specified risk level.



2.0 STARTING SiteStats

Written and compiled in Visual Basic, the software does not require any
purchased applications support since it was developed as a stand-alone executable. The
Remediation Planning Tool database used is in Access 2.0. The user does not need to

know anything about Visual Basic or Access for code execution.

2.1 System Requirements

* A master copy of the SiteStats 1.0 Disk,

*  An IBM PC or compatible computer,

* A graphics card compatible with Microsoft Windows 3.0 or later,
* 4 megabytes (MB) of random-access memory (RAM),

*  MS-DOS version 3.1 or later and Microsoft Windows 3.0 or later,
* A mouse or other compatible pointing device,

* 10 megabytes (MB) of hard disk storage space.

2.2  Installing the Software

*  Start Microsoft Windows.
*  Insert the master disk into drive A or drive B.

*  From the File menu in either the Program Manager or File Manager,
choose Run (A dialog box similar to the one shown in Figure 2.2-1.)

*  Type (a:setup) or (b:setup) depending on which drive is in use.
*  Click OK.

*  Follow any additional instructions provided on the screen.



i Hun

Command Line:

Ib::etup

(] Run Minimized

Figure 2.2-1. Run Command Line

2.3  Launching SiteStats

* In the Program Manager window, double-click the SiteStats group icon
or the group icon that contains SiteStats 1.0.

*  Double-click the SiteStats program icon, as shown in Figure 2.3-1.

SiteStats

/ bttt 1

Double Click to Launch

Figure 2.3-1. SiteStats Program Icon

24  Exiting From SiteStats

*  From the SiteStats File menu choose Exit.

* A dialog box will appear asking the user to verify the decision to quit, see
Figure 2.4-1.

*  Click Exit to quit or Cancel to remain in the program.



File Yindow Help

Sifo.an te T 1)

m bt Peogeasn
Are you sure you want to exit the program ?

— (—

Figure 2.4-1. Exit Program

2.5 SiteStats Code Limitations

SiteStats 1.0 was developed and written in Microsoft Visual Basic for Windows.
As such, any limitations imposed in the development language will also restrict the
executable code. Presently, users are limited to 30,000 grids within any sector.
Additionally, users should avoid the use of punctuation within edit fields as this may
cause problems when retrieving data once it has been saved. SiteStats operates within a
single site area, or sector, at a time, sampling individual grids one at a time. All sampling

grids in SiteStats have the same dimensions.



3.0 BASICS OF USING SiteStats

31 Commands and Menus

SiteStats offers two ways to choose commands:
* From the menu bar,

*  Using shortcut keys.

For additional instruction about choosing menu commands, refer to the Microsoft
Windows User's Guide.

SiteStats commands are grouped on menus, see Figure 3.1-1. Menu names appear
in the menu bar across the top of the application windows. Different windows will have

different menu bars.

Menu Bar SiteStats
X Window Help
New Evaluation Sector Characterization
Available Remediation Planning Tool
—

Shorteut
Key

SiteStats 1.0

S vy Covps of Frgineers, Hurdsedlfe Dicisoon

Figure 3.1-1. Sample Menu



Choosing a Command from the Menu Bar:

* Point to the menu name in the menu bar that contains the command you want,
drag the mouse to that command, and then release it to select the command.

* The user may also click the menu name and then click the command.

* Use the keyboard (instead of mouse) by typing the underlined letter in the
desired command.

3.2  Dialog Boxes

SiteStats displays numerous dialog boxes to obtain information from the user, see
Figure 3.2-1. These dialog boxes may include areas in which text or numbers are entered.
Dialog boxes may also allow settings to be changed or notify the user of some decision.

It may also display additional information or request confirmation.

For more information about general dialog box procedures, consult the Microsoft

Windows User's Guide.

Site/Sector Designation

Site Location: |

Sector 1D:

Date: |4/24/95

Sector Type
@® Dispersed O Localized

Figure 3.2-1. Site/Sector Designation




3.3  Opening Saved Data

*  Choose Open from the File menu.

* A dialog box, similar to the one shown in Figure 3.3-1, appears allowing the
user to switch drives and/or directories.

*  Select the desired file.

*  Click the OK button to open the file.

File Name:

Directories:

c:Asitestat

plant .txt
plan10.txt
plan100.txt
plani1.txt
planl2.txt
plan13.txt
plan1 4. txt
plan15.txt

= o\
@ sitestat

[] Read Only

List Files of Type:

Drives:

| SiteStats(=. TXT)

c: quantitechl

3.4  Saving Data

Figure 3.3-1. Opening Saved Data

When you finish a SiteStats session, save your data before you exit the program.

Two commands on the File menu will allow the user to save the data.

*  Use the Save As command to save your data for the first time and give it a
name, see Figure 3.4-1.

* Use the Save command to save changes to an existing data file.



S?:we As

File Name: Directories:
[vsal txt c:\sitestat

plant_txt &= e\

plond 0. txt :
plan100._txzt 2 sitestal
plani? txt
planl2 txt
plan1 3 txt
planl4 txt
planlb . txt

Save File as Type: Drives:
| SiteStats{=.TXT) c: quantitech1

Figure 3.4-1. Saving Files

3.5 Beginning a New Evaluation

Two basic types of analysis can be performed with SiteStats: Sector

Characterization and Remediation Planning.

Sector Characterization is available for use in site/sector sampling that occurs as
part of the Engineering Evaluation/Cost Analysis process. In this mode, SiteStats
operates as a real-time field tool. Remediation Planning is available for a site Program

Manager’s use in evaluating alternative site remediation approaches.

*  Choose New Evaluation from the File menu, see Figure 3.5-1.
*  Select either Sector Characterization or Remediation Planning Tool.



SiteStlaty
NG Yindow Help
New | valuation Sector Charactensation

RBemediation Planning Tool

SiteStats 1.0

US Aviny Chrps of Enoineers, fHlondsoille Dicision

Figure 3.5-1. File Menu
3.6  Other Menus on the Main Screen
In addition to the File menu, a Window menu and Help menu exist on the main
screen. From the Window menu the user may choose Display Sector to view the
sector map. The Help menu allows the user to display information about SiteStats.
3.7  Error Messages
SiteStats determines if a user's inputs are valid. If a mistake is made, a message

will appear to bring attention to the problem. In the example in Figure 3.7-1, the total

percentage of labor hours in the Field Cost Model did not equal 100%.



Common Labor:

Percentages Must Total to 100%

Check Here to Make the Current Settings the Default

— | —

Figure 3.7-1. Input Error Example
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4.0 BUILDING A NEW SECTOR (SITE CHARACTERIZATION)

When a new site characterization evaluation is selected, a unique sector
representation will be created by the user. The sector is represented as a rectangular
block diagram composed of numerous grids, see example in Figure 4.0-1. Grids are

identified by row and column numbers.

Figure 4.0-1. Example Sector

4.1  Dispersed vs. Localized

Dispersed sectors are those where you would expect to find ordnance distributed
across the sector. An example of a dispersed sector is an impact area. Localized sectors
have isolated concentrations of ordnance. An example of a localized sector is a burial pit
which contains some type of hazardous material. The user has the option of selecting

either type of sector at the beginning of a new sector characterization. (See Figure 4.2-1.)

4.2 Sector Name and Location

Each new sector can be described by Site Location and Sector Identification, see

Figure 4.2-1. Additionally, a Start Date can be provided. Although these inputs are

11



optional, it is recommended that the user provide this information. The site location and

sector identification fields are unique, meaningful labels assigned by the user.

SitefSector Designation

Site Location: |Camp Swampy

| Sector ID: |Impact Range]

| Date: |30 Apr 95

| Sector Type
@ Dispersed O Localized

Figure 4.2-1. Site/Sector Designation

4.3 Sector Dimensions

Sector Length and Sector Width measurements must be input by the user as
shown in Figure 4.3-1. These values should be determined by visualizing a rectangle that
would completely encompass the sector of interest. Although the sector may not be
rectangular in shape, the user will have an opportunity to refine the sector representation

later.

12



Sector Dimensions

Help

Enter the Horizontal Length of the Sector: ||

Enter the Vertical Width of the Sector:

Enter Appropriate
Dimensions Here

 Units of Measure
@ Feet
O Yards " ——__ Select Unit
of Measure
O Miles
O Meters

Click to Enter
the Dimensions

Figure 4.3-1. Sector Dimensions

44  Grid Dimensions
After entering sector dimensions, the user will be prompted to enter the size of the

individual grids, see Figure 4.4-1. This grid size will remain constant throughout the

sector. Follow the same steps used in entering the sector dimensions.

13



Grid Dimenstons

Enter the Horizontal Length of the Grid:

Enter the Vertical Width of the Grid:

~ Units of Measure

@ Feet
O Yards
QO Miles

O Meters

Figure 4.4-1. Grid Dimensions
4.5 Verifying Dimensions
Once the sector and grid dimensions have been entered, a dialog box asking for
verification will appear as shown in Figure 4.5-1. If the dimensions shown are correct,

then click Dimensions Correct. Otherwise, to change either the sector or grid size,
click Change Dimensions.

14



Yerity Sector and Grid Dimensions
I

| Sector Length: 500 Feet
Sector Width: 500 Feet
Grid Length: 100 Feet

Grid Width: 100 Feet

Figure 4.5-1. Sector/Grid Dimension Verification

4.6 Localized Sector Centroid

If a Localized Sector Type was selected earlier, the centroid of the OEW
contamination must be specified within the new sector. A dialog box will appear
requesting the user to enter the origin (i.e., center) of the localized site as shown in Figure

4.6-1. This location should be the area of expected highest OEW concentration.

Localized Sector Origin

Column Number (X Axis): |5
Row Number (Y Axis): |6

Figure 4.6-1. Localized Sector Origin

15



When the dialog box appears, the edit fields will already have values. These
default values are the exact center of the sector which was created. Should you choose to
use these values simply click OK, otherwise, identify the location in terms of row and

column.

16



5.0  FIELD COST MODEL (SITE CHARACTERIZATION)

5.1  Field Cost Model Usage

The Field Cost Model is a tool which predicts the cost of sampling a grid within
the sector. This cost estimate is based on sector terrain, the number of anomalies in the
grid, and the composition of the team performing the sampling (UXO Specialist, GIO
Specialist, and Common Laborer). The Field Cost Model executes during the grid

sampling portion of SiteStats.

5.2  Describing the Terrain

The user must provide an overall assessment of the terrain within the sector as
shown in Figure 5.2-1. This characterization is defined during the construction of a new
sector. The terrain description comprises: slope (either 0°-10°, 10°-30°, or >30°);
vegetation density (either clear, grass/brush, trees, or marsh); soil type (either light soils -
sand or loam, or heavy soils - clay or rock); and footing conditions (either slippery or

non-slippery). A sector is assumed to have the same general terrain conditions.



Field Cost Model - Inputs

- Slope of Terrain ~Vegetation

@ Level (O -10) ® Cloar

QO Brush
O Moderate (10 - 30)

QO Trees

O Steep (>30) O Marsh

- Soil Density  Other Properties
@ Light - Sand or Loam QO Slippery

O Heavy - Clay or Rock @ Not Slippery

Available Funds for Characterization (ex. 10000): 2500'

Figure 5.2-1. Field Cost Model Inputs

*  Select the predominant slope of the sector. (Level, 0-10°; Moderate, 10 - 20°,
Steep > 30°.)

* Choose the appropriate soil type.
*  Choose the predominant vegetation density type.

Select the Slippery or Not Slippery factor based upon the footing condition
within the sector.

Enter the available funds for characterizing the entire sector. Use only whole
dollars with no punctuation. (Note: This input is optional. Provide a value
only if you wish for SiteStats to perform the necessary accounting.)

18



53 Hours Breakdown

Included in the estimate for sampling a grid is a value for the labor required to
identify and investigate the grid’s anomalies. The cost of this labor is dependent upon the
skill level of the team members. The user can adjust the labor type percentages as shown
in Figure 5.3-1. The default provided is 100% UXO Specialist. The total percentage
must add to 100% or an error message will appear to prompt the user to adjust

accordingly.

Field Cost Model Hours Breakdown

7 18 Click the

Common Labor: 0 % F Arrows to
] " Adjust the
Percentages

Geophysical Instrument Operator: 5 9% Z:

UXO Specialist: 95 FR
P % A 4

Total Percentage: 100 %

Check Here to Make the Current Settings the Default

—

Checking this this box allows SiteStats to remember the values.

Figure 5.3-1. Field Cost Model - Hours Breakdown

54 Field Cost Model Results

Using the sector description and team composition identified by the user, the
Field Cost Model predicts the expected cost to sample the grid chosen or identified for
investigation. The user is informed of the estimated cost to sample each grid as shown by
the example in Figure 5.4-1. The cumulative expenses, remaining funds and total budget

are also displayed.

19



Field Cost Model Results

Expected Grid Cost:. $85

Sector Characterization Expenses to Date: $2.952

Funds Available Presently: -$452

Total Funds Budgeted for Sector Characterization: $2,500

Figure 5.4-1. Field Cost Model - Results

* Click Continue to proceed with the grid sampling.

* Click Stop if the funds required or expended exceed the budget you have
identified for investigation of grids within the sector.

20



6.0 SECTOR MAP FEATURES (SITE CHARACTERIZATION)

6.1  Map Description

The example sector representation in Figure 6.1-1 is a rectangle defined by the
user-supplied sector and grid dimensions. In this particular example a 500’ x 500” sector

was created with 100’ x 100’ grids. The total number of grids is 25.

Figure 6.1-1. Example Sector Representation

6.2 Refining the Map/Removing Grids

The initial sector map is created based upon the maximum length and width to
completely encompass the sector. The user may refine the visual representation of the

sector by removing grids which do not belong to the sector ( e.g., lakes, buildings, etc.).

* Remove a grid by first clicking in the grid to be removed, then choosing the
Remove/Add Grid From Sector on the Tools menu, see Figure 6.4-1.

* The selected grid will be colored black, thereby indicating that it does not
belong to the sector.

* If you wish to add a grid back to the sector, again, select the grid to be added
and choose the Remove/Add Grid From Sector command on the Tools
menu.
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Figure 6.2-1. Refined Sector Representation

The sector representation is the portion in white which remains as shown in

Figure 6.2-1. The sector cannot be refined after sampling has begun.

6.3  Viewing Data

Three types of data can be displayed within SiteStats: Grid Data, Sector Data, and
Cluster Data. Cluster Data will be displayed only after clustering (separating an initial
sector into multiple sectors with homogeneous OEW contaminant density) an initial
dispersed sector into multiple sectors, and individual grid data will not be displayed for a

localized sector.

*  Select the Results menu, see Figure 6.3-1.

* Choose the type of data to be displayed.
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Sector Hepresentation @ | pected U0

| Tools NAISNTI

Gt Bratg

Sample A Grid Wilhin The Sector

Figure 6.3-1. Results Menu

6.4 Other Menus

The Tools menu, Figure 6.4-1, contains the most frequently used sector map
commands. An illustration is provided below. The View menu allows the user to
display a map of non-UXO items and a map of interpolated UXO values. (Note: The

interpolated UXO map will be available only after clustering the sector.)
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Besults View

Remove/Add Grid from Sector Cul+G
Zoom InjOut

Sample Active Grid Ctris+S
Random Sample Cui+R
Return to Main Menu CtrisM

Figure 6.4-1. Tools Menu
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7.0  GRID SAMPLING OF DISPERSED SECTORS (SITE
CHARACTERIZATION)

7.1 Random and Non-Random Sa:-ling

After the sector refinement is complet~d, grid sampling may begin. Once grid

sampling has begun no additional sector refinement may be performed.

Sampling a Specific Grid
*  Select the grid on the sector map.

*  From the Tools menu choose Sample Active Grid.

Random Sampling

*  From the Tools menu choose Random Sample.

*  The location of the grid to sample will be identified.

7.2  Sampling Plans

Before sampling a grid within the sector, the software will select a grid sampling
plan as shown in the example in Figure 7.2-1. The sampling plans are provided to ensure
the anomalies within a grid are investigated in a random process. One hundred pre-
defined sampling plans are available for selection, each providing a sequence of 1500
locations for anomaly investigation selection. The sequence list will serve as the grid

investigation map.
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Sampling Plan Selection

Use Sampling Plan Sheet Number
92

Figure 7.2-1. Sampling Plan Number

* Click Print to generate a printed copy of the sampling plan. (This is
recommended for field use.)

* Click OK to proceed with sampling.
7.3  Entering the Number of Grid Anomalies

The total number of anomalies within a grid must be known prior to sampling.
(This assumes that the entire grid has been swept and anomalies have been flagged.) The

total number of anomalies are input directly as shown in the GridStats Initialization

screen, Figure 7.3-1.
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GridStats Evaluation

Site Location: Camp Swampy
Sector ID: Impact Range

Grid Location: Row 1 Col 1

Total Anomalies in Grid: |200

Date: (30 Apr 95

Grid Number: 1

Figure 7.3-1. GridStats Initialization

7.4  Interfacing with the Field Cost Model

SiteStats will initiate a Field Cost Model analysis after the number of grid
anomalies are entered. The Hours Breakdown dialog will appear as was shown in Figure
5.3-1. Once the hourly percentages have been set, the estimated grid cost will be
displayed. (Refer back to Figure 5.4-1.) Use the instructions provided in Section 5.4 to

terminate/continue sampling at this point.
7.5  Cost and Risk Error

Current and predicted levels of cost and risk error are displayed prior to sampling
a grid, see Figure 7.5-1. Risk Error is the probability of concluding that the grid is
insufficiently contaminated when it is sufficiently contaminated. Cost Error is the
probability of concluding that the grid is sufficiently contaminated when it is
insufficiently contaminated. (Note: This information is not calculated or displayed
before sampling the first grid in the sector.) If the values are unacceptable, click Stop to

halt the sampling. Click Continue to proceed.
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SiteStats Cost and Hisk Evaluation

Current Cost Error: 1.0000
Current Risk Error: 0.6538
Predicted Cost Error After Next Grid Sample: 1.0000
Predicted Risk Error After Next Grid Sample: 0.3692
Expected Grid Cost: $1.002

| — [ —

7.6

Figure 7.5-1. Cost and Risk Errors

Explanation of the Grid Sampling Screen

*  Click the anomaly type (refer to GridStats Sampling Display, Figure 7.6-1).
* Click Record This Sample to identify the anomaly.

* Click Halt Sampling - Save Data to conclude grid sampling based upon
current information. (You will not be able to continue sampling this grid
later.)

* Click No Anomalies - New Location when no anomalies are present in
the current subgrid square.

* Click Quit - Discard Data to halt sampling without concluding. (This grid
may be sampled at a later time, but all data relating to previous sampling of
this grid is discarded.)
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elp

Camp Swampy
11917125 Grid Location { Impact Range
/210m Row 1 Col 1

g:l:::)eg:l:s 3 [11119]27 Enter Data for ?52ple Néjmb?;: .
anomaly urren y
hﬁi;migfm 4 112[20|28 - Specify type of item found at anomaly —]
square

5|13|21(29) O uxo

s 1212230 anomaly — TP @ UXO Scrap/Shrapnel

O Non-UXO False Positive
711612331 O Surface UX0
8 |16|24|32

Cost Error Not Calculated

Risk Error Not Calculated

Number of Surface UX0 ltems: 0

Figure 7.6-1. GridStats Sampling Display
7.7  Surface UXO
SiteStats assumes that all ordnance found on the surface during an EE/CA
investigation will be identified and removed. The GridStats sampling routine provides

for an accounting of surface UXO, see Figure 7.7-1. Surface ordnance data is not used

within this software to draw any statistical characterization of sub-surface UXO content.
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Help

Camp Swampy

bl el Al impact Range
2 (10 Wﬂ Row 1 Col 1
3 |11]19(27 Enter Data for S|amp'e Number:
4 112(20|28 rSpecify type of item found at anomaly —
5 |13|21|29 O uxo
6 [14]22[30 O UXO0 Scrap/Shrapnel
O Non-UXO0 False Positive
i ®Suriace U0 #—Suriact X0 e
8 16 24 32 € ck Recol

Cast Errar Not Calculated

Risk Error Not Calculated

Number of Surface UXO ltems: 1

The number of surface UXO located
in this grid is displayed here

Figure 7.7-1. Surface UXO Count

7.8 Grid Characterization

Continue sampling anomalies within a grid until one of the three following

statistical conclusions can be determined, as shown in Figures 7.8-1 through 7.8-3.
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Grid Sampling May Be Terminated
Insufficient Contamination

Figure 7.8-1. Less Contaminated Grid

The message in Figure 7.8-1 will be displayed when the grid may not require

remediation.

GridStats Result

Grid Sampling May Be Terminated
Sufficient Contamination

Figure 7.8-2. More Contaminated Grid

The message in Figure 7.8-2 will be displayed when the grid may require

remediation.
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GridStats Result

Grid Sampling May Be Terminated
Sufficient Grid Characterization

Figure 7.8-3. Grid Sufficiently Characterized

The message in Figure 7.8-3 will be displayed when the grid is otherwise

characterized.

Notice that additional grid sampling can be performed after a conclusion has been

drawn. Click Continue Sampling Grid to investigate additional anomalies.

7.9  Marking Grid Results on the Sector Maps

When individual grid sampling has been concluded, the grid will be highlighted
on the sector maps. The sampled grid will be highlighted in red with the expected UXO
printed in white. On the False Positives map, the grid will be highlighted in blue with the
expected non-UXO printed in white. The Frlse Positive map can be displayed by
choosing Map of False Positives from the View menu. In the example in Figure
7.9-1, the expected UXO items in the marked grid is 37. In the example in Figure 7.9-2,
the expected non-UXO items in the marked grid is 213.
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Figure 7.9-1. UXO Count in Grid

Figure 7.9-2. Non-UXO Count in Grid
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8.0  GRID SAMPLING OF LOCALIZED SECTORS (SITE
CHARACTERIZATION)

8.1 Marking the Localized Centroid

For localized sectors, a centroid has been provided. (See the discussion in Section
4.6.) To highlight the centroid on the sector map choose Mark Localized Centroid
from the Tools menu. The centroid will be highlighted as shown in Figure 8.1-1.

/-

Centroid of Localized Sector

Figure 8.1-1. Localized Sector Centroid
8.2  Explanation of the Localized Grid Sampling Screen

After investigating the chosen/identified grid, record the results of the

investigation on the Localized Sector Inspection Results screen, see Figure 8.2-1.

Localized Sector Inspection Results

Row 1 Col 1

Results of Inspection

@ No UXO0 Found O UXO0 Found

Figure 8.2-1. Localized Grid Sampling Screen
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8.3  Marking Sampled Grids on the Sector Map

When individual grid sampling has been concluded, the grid will be highlighted
on the sector map as shown in Figure 8.3-1. If UXO was found in the sampled grid, it
will be highlighted in red with the word “UXO” printed in white. If no ordnance was
found in the sampled grid, it will be highlighted in blue with the word “CLEAR” printed

in white.

Grid where ordnance was found
No ordnance found in these grids

-

}

Localized Centroid

Figure 8.3-1. Localized Sector
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9.0 CHARACTERIZING A SECTOR

Sampling of individual grids within a sector should continue until some

conclusion concerning ordnance contamination characterization can be reached.

9.1 Dispersed Sector Conclusions

The two conclusions, as shown in Figure 9.1-1 and 9.1-2 can be drawn after

sufficient sampling within a dispersed sector.

Sector Characterization

Non-Homogeneous UX0O Density Within Sector

Figure 9.1-1. Non-Homogeneous Sector

Sector Characterization

Homogeneous UXO Density Within Sector

Figure 9.1-2. Homogeneous Sector

The conclusion shown in Figure 9.1-1 indicates that the initial sector defined by
the user is not valid in terms of UXO density, i.e., the area is truly more than a single

sector with respect to ordnance contamination density, and should be further subdivided.
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The conclusion shown in Figure 9.1-2 indicates the initial sector defined by the user is

valid in terms at UXO density.

9.2 Localized Sector Conclusions

The two conclusions, as shown in Figure 9.2-1 and 9.2-2 can be drawn after

sufficient sampling within a localized sector.

Sector Characterization

Evidence of Further Contamination

Figure 9.2-1. Localized Sector Further Contaminated

Sector Characterization

No Evidence of Further Contamination

Figure 9.2-2. Localized Sector Not Contaminated

The conclusion shown in Figure 9.2-1 states that the results of the sampling
indicate that the localized sector contains OEW contamination outside the identified
centroid. The conclusion shown in Figure 9.2-2 states that the results of the sampling

indicate that the localized sector does not contain OEW contamination.
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9.3 Clustering Dispersed Sectors

SiteStats may conclude that the initial sector is actually more than one sector
because of differences in UXO contamination density levels. The user will be prompted
to cluster the sector. The suggested number of clusters will be provided in the edit field
as shown in Figure 9.3-1, however, the user may override the SiteStats recommendation.

The maximum number of clusters is six.

SiteStats provides
the suggested
number of clusters

Enter the Number of Clusters:

—

Click OK to Cluster

Figure 9.3-1. Sector Clustering

Once the data has been clustered, the sector map will appear like the one in Figure

9.3-2. This example shows two clusters (or sectors) within the initial sector boundaries.

Figure 9.3-2. Clustered Sector Map
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During the clustering procedure both UXO and non-UXO values are interpolated
into those grids which were not sampled. To display the interpolated values go to the
View menu.

To display the non-UXO interpolated values choose Map of False Positives
from the View menu. A sector representation similar to the one in Figure 9.3-3 will
appear. Notice that the highlighted grids are those that were sampled. All other grids

contain interpolated values.

0 5 7 8 8
0 0 10 10
HIll -

0 0

Figure 9.3-3. False Positive Map (With Interpolated Values)

To display the UXO interpolated values choose Map of Interpolated UXO
from the View menu. A sector representation similar to the one in Figure 9.3-4 will
appear. Notice that the highlighted grids are those that were sampled. All other grids

contain interpolated UXO values.
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Figure 9.3-4. UXO Map (With Interpolated Values)
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10.0 VIEWING SITE CHARACTERIZATION DATA
10.1 Sector Data
Two methods are available to display sector data shown in Figure 10.1-1.

* Choose Sector Data from the Results menu at any time during code
execution. Current values will be displayed.

* Click the Display Results button on the sector conclusion dialog box.

Sector Characterization Results
Sector Characterization Results

Site Name: Camp Swampy

Sector ID: Impact Range

Date: 30 Apr95

Number of Grids: 25

Minimum Number of Grids to Sample: 7

Average Number of Grids to Sample: 13

Maximum Number of Grids to Sample: 20

Number of Grids Sampled: 12

Grid Area: 10,000 Square Feet

Expected Number of Sub-Surface UXO Items: 19 per grid
Expected Density of Sub-Surface UXO ltems: 1.90E-03 per square foot
Expected Number of Non-UXO ltems: 6 per grid

Expected Density of Non-UXO ltems: 6.00E-04 per square foot
Total Number of Sub-Surface UXO ltems Found: 27

Total Number of Surface UXO items Found: 10

CostError: 0.1915

Risk Error: 1.0000

Figure 10.1-1. Sector Characterization
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10.2 Grid Data
Two methods are available to display grid data presented in Figure 10.2-2.

* Choose Grid Data from the Results menu at any time during code
execution.

* Enter the grid number in the dialog box shown in Figure 10.2-1 and Click OK.

— Yiew Grid Data

Enter the Grid Number: |11

Figure 10.2-1. Viewing Grid Data

*  Click the Display Results button on the sector conclusion dialog box.
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GridStats Results
Site Name: Camp Swampy
Sector ID: Impact Range
Grid Location: Row 2 Col 1
Date: 30 Apr95
Grid Number: 11
Number of Anomalies: 50
Number of Samples Collected: 15
Number of Sub-Surface UXO ltems Found: 11
Number of False Positive tems Found: 1
Number of UXO Scrap Items Found: 3
Number of Surface UXO tems Found: 3
Expected Number of Sub-Surface UXO ltems: 37
Expected Number of Non-UXO ltems: 13
Sample Plan Number. 61
CostError: 0.0000
Risk Error. 1.0000

NOTE: Risk Error is the probability of concluding that the grid is
insufficiently contaminated when itis sufficiently contaminated.

Cost Error is the probability of concluding that the grid is sufficiently

contaminated when it is insufficiently contaminated.

Figure 10.2-2. GridStats Results

10.3 Cluster Data
Cluster data as shown in Figure 10.3-1 will be displayed only after an initial

sector has been clustered into two or more distinct sectors. To view the data choose

Cluster Data from the Results menu.
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Sector Cluster Resulis

. SiteStats Cluster Rasults

Cluster Number.: 1

Color: Red

Number of Gnids in Cluster: 18
Number of Sampled Grids in Cluster. 7
Area of Cluster: 180,000 Square Feet
Expected Number of Non-UXO items: 8 per grid

Expected Non-UXO Density: 8.00E-04 per square feet

Expected Number of Sub-Surface UXO: 10 per grid

Expected Sub-Surface UXO Density: 1.00E-03 per square feet
Number of Surface UXO Found in Cluster: 3

Expected Number of Surface UXO: 0 per gri!

Expected Surface UXO Density: 0.00E+00 per square feet
Expected Percentage of UXO To Be Found On The Surface: 0.00%
Total Number of Expected UXO ltems: 10 per grid

Expected Total UXO Density: 1.00E-03 per square foot

Cluster Number; 2
Color; Green

Figure 10.3-1. Sector Cluster Results




11.0  REMEDIATION PLANNING TOOL

11.1 About the Code

The Remediation Planning Tool (RPT) is written in conjunction with and integrated
into the SiteStats code, though it may be run separately from the File Manager. Its
purpose is to allow the user to generate “what-if” scenarios for site remediation based on
dollars available, probability of exposure reduction goals, and work levels. Users can
quickly quantify and graphically examine remediation options, and optimize planning
based on the results. The tool is extremely flexible with its inputs, and is designed for ease
of use and clarity of results.

11.2 Launching the Code

RPT is launched by selecting Remediation Planning Tool under the File menu
and New Evaluation sub-menu. The SiteStats Site Characterization code closes (for
purposes of RAM conservation), and RPT is launched. The user may, alternatively, launch
RPT as a stand-alone code by selecting RPT.exe from the File Manager. The
executable is located in the SiteStats directory.

The code consists of a series of input screens for parameters, followed by
algorithm execution and display of output, which is in both text and chart format. The user
then may save or print the results. Finally, the user may exit or start a new run.

The initial screen has two buttons. (See Figure 11.2-1.)

* To launch RPT, click Begin or press Return or Enter.
* To exit RPT, click Exit.
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11.3  Fixed Parameter Dialog Box

When the user has chosen to begin a run, a dialog box appears containing options
for the type of fixed run the user wants to make (see Figure 11.3-1).

Stlect the fixed parameter

[~ Parameter

O Probability of Exposure (0-1)

@ Site Cost ($)
O Clear Depth (Feet)

Fixed Value: |1000000

Figure 11.3-1. Fixed Parameters

The user can fix cost, risk (expressed in terms of the probability of exposure
associated with a single individual’s one-time visit to the site), or clear depth. RPT will
calculate the value of the two parameters not fixed for th.at run. The parameters and their
associated properties are shown in Table 11.3-1.

Table 11.3-1. Fixed Parameters Options

Parameter Units Range of Values
Probability of Exposure probability (0-1)

Cost dollars (>0)

Clear Depth feet (0-10)
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For RPT to find the other two parameters, the user must input the value at which to
fix the selected parameter. This value is entered into the text box with the Fixed Value:
label. Upon completion of the run set, the fixed value will be interpolated based on the
neighboring values determined by varying clearance depth from 0-10 feet in one-half foot
increments. When the user has input the fixed value and parameter selection, the run can
be continued by selecting OK, or stopped by selecting Cancel. The user may also select a
button or other control on the form by repeatedly pressing the tab key until the desired
control becomes highlighted. If the user puts an unreasonable input into the Fixed Value:
box, the RPT will inform the user and return to the box so that the number can be
reentered.

11.4 Site Data Inputs

The next input screen shown will be for site specific information. Although there
are several data inputs on this screen, only eight of them are activated for this code version.
These parameters along with their bounds and units are listed in Table 11.4-1.

Table 11.4-1. Site Inputs

Site Parameter Units Range
Site Name — -——-
Site Area Acres >0
County Area Sq. Mi. >0
City Area Sq. Mi. >0
State ---- ----
Number of Szctors # 0-1000
Guards Required # >0
Number of New Construction Permits # >0

The user is asked for the site name, site area (in acres), number of guards required
for remediation, number of sectors in the site, city and county area (in square miles), state,
and number of new construction permits. The Site Input Screen is shown in Figure
11.4-1. The unused (grayed out) inputs involve other site data not currently needed for
RPT. The user again has two buttons at the bottom of the window, Cancel to exit the
code and OK to continue the analysis run.
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Site Data

Figure 11.4-1. Site Inputs
Repeatedly pressing Tab toggles the user from control to control (text boxes and
buttons), allowing the user's hands to never leave the kcyboard. Unrealistic and non-
existent inputs are brought to the user's attention so that the analysis will be legitimate.

11.5 Sector Type Dialog Box

After the site inputs screen, a dialog box is displayed (see Figure 11.5-1) requesting
the sector type.
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sector Type

 Sector Types
@® Dispersed Sector

O Lecalized Excavation
O Localized Surface

O Localized Building
i1 Dispersed Water

i Localived Watey

Figure 11.5-1. Sector Type

The user has four active options (water logic is not currently included in RPT)
which are: Dispersed, Localized Excavation, Localized Surface, and Localized Building.
Each sector type has an associated set of algorithms used to characterize risk and cost.

* Select the sector type and click OK.

This box will appear one time per each sector as quantified on the site inputs screen.
The next input boxes displayed depend on the selection made by the user at this point.
Each of the four possible paths is discussed in the following sections.

11.5.1 Dispersed Sector Inputs

If the user has selected Dispersed Sector (indicating the sector is contaminated
across a large area with randomly dispersed OEW), the Sector Data input box will be
displayed next, as seen in Figure 11.5.1-1. As with the Site Data input box, there will be
several grayed inputs, some unused by dispersed sectors, others unused in this version of

RPT. For a dispersed sector, twenty-three sector inputs are necessary. These values, along
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with their ranges and units, are listed in Table 11.5.1-1. This box will appear one time per
dispersed sector (each time the user selects Dispersed Sector in the Sector Type
dialog box). The user can exit the code by selecting Cancel or continue by clicking OK.

Sector Number 1
n0°-30°)| {3
|
Clear | |

b
CH—
[
I
(R
[
C—
—
I
R
—
I
—
—

-
]

Figure 11.5.1-1. Dispersed Sector Data Input Screen
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Table 11.5.1-1. Dispersed Sector Inputs

Parameter Units Rﬂge 4
Sector Area (SA) Sq. Mi. 0 < SA < Site Area
Slope degrees select from categories
Soil Type — select from categories
Vegetation Density ---- select from categories
Area Farmed Sq. Ft. 20

Area Ranched Sq. Ft. 20

Archeological Area Sq. Ft. 20

Area for Metal Detecting Sq. Ft. 20

Extraordinary Environmental Costs $ >0

Burning Allowed Yes/No —

Slippery Yes/No —

Portion of OEW on Surface % 0-100

OEW Density #/Sq. Ft. >0

UXO Weight Ibs >0

Percent UXO % 0-100

Percent LMS % 0-100

Percent WP % 0-100

Percent CBR % 0-100

Total Density #/3q. Ft. >0

Number of CWM Tents # 20

Snakes Yes/No —

Bees Yes/No -o--

Poisonous Foliage Yes/No —

Following the dispersed sector input screen, an activity window will open.

window contains a list of activities that may occur in the current sector of interest.

window is shown in Figure 11.5.1-2.

*Click on check box to the left of all activities occurring in sector
* Click OK to proceed or Cancel to quit.
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This window will also appear one time per dispersed sector in the site. If the user
selects Construction as one of the activities, an input box will appear later in the run.
This box (Figure 11.5.1-3) will prompt the user to input the construction intrusion depth in
feet.

Activities for Sector]

D(
n
[
n
]
]
n
|
]
n
u
|

Input the construction
intrusion depth in feet.

Figure 11.5.1-3. Construction Depth Box
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After selecting the activities for the current dispersed sector, a cost data screen will
be activated, as shown in Figure 11.5.1-4. This screen asks the user for information about
rates, labor mixes, and remediation techniques

* Select optional labor rates and numbers, check boxes and input associated rates
for checked boxes.

* (Click OK to continue or Cancel to terminate.

The rates and mixes on the right side of the window are not optional, thus no check
box is associated with them. If the form of excavation selected is Mechanical Only, then
a small dialog box, shown in Figure 11.5.1-5, appears and asks the user to define how the
cxcavated volume is to be removed.

* Click Sift Off Site, Haul away, or Sift On Site.
* Click OK.

For discussion of the display of the results, turn to Section 11.6.

Sectar Cost Data {”— rm

£
ﬁ "

=

2700
600 |
250 |
100 |
[
L
L
7279
77.06 |
2321 |
50.00 |
96.27 |
29.79 |
17.76
[

11

Figure 11.5.1-4. Sector Cost Data
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Removed Vaolume Options

Figure 11.5.1-5. Removed Volume Options Box
11.5.2 Localized Excavation Inputs

If the user has selected Localized Excavation indicating the sector contains only
a localized area of buried OEW, an input box will appear asking for the maximum
ordnance depth in feet. This box is shown in Figure 11.5.2-1. The Sector Data input
box will be displayed next, as shown in Figure 11.5.2-2. This window is similar to the
window used with dispersed sector inputs, but with some tailoring for the localized sector
characteristics. As with the Site Data input box, there will be several grayed inputs, some
unused by localized excavation, others unused in this version of RPT. For localized
excavation, twenty sector inputs are necessary. These values, along with their ranges and
units, are listed in Table 11.5.2-1. This box will appear one time per localized excavation
(each time the user selects Localized Excavation in the Sector Type dialog box).
The user can exit the code by selecting Cancel, or continue by clicking OK.
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— Ordnance Depth

What is the maximum I ‘
depth (ft) of the localized -
ordnance? -l .

Figure 11.5.2-1. Localized Excavation Ordnance Maximum Depth

Sector Number 1

(10°-30%)| |
&
Clear | [}

X

17 Il

Figure 11.5.2-2, Localized Excavation Input Box
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Table 11.5.2-1. Localized Excavation Sector Inputs

Parameter Units iﬁe

Sector Area (SA) Sq. Ft. 0 < SA < Site Area
Slope degrees Select from categories
Vegetation Density — Select from categories
Area Farmed Sq. Ft. 20

Archeological Area Sq. Ft. >0

Area for Metal Detecting Sq. Ft. 20

Extraordinary Environmental Costs | $ 20

Burning Allowed Yes/No o

Slippery Yes/No -—--

Armed UXO Yes/No —

Unarmed UXO Yes/No --—-

Explosives and Materials Yes/No —

Propellants and Pyrotechnics Yes/No ----
Non-Controlled Chemical Yes/No ----

White Phosphorus Yes/No -

Localized CBR Yes/No —

Number of CWM Tents # >0

Snakes Yes/No ----

Bees Yes/No ----

Poisonous Foliage Yes/No ----

Following the Localized Excavation Sector Input screen, an activity window will

interest. This window is shown in Figure 11.5.1-2.

open. This window contains a list of activities that may occur in the current sector of

* Click on check box to left of all activities occurring in sector
* Click OK to proceed or Cancel to quit.

This window will also appear one time per Localized Excavation Sector in the site.

depth in feet.
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If the user selects Construction as one of the activities, an input box will appear later in
the run. This box (Figure 11.5.1-3) will prompt the user to input the construction intrusion




After selecting the activities for the current localized sector, a cost data screen will
be activated, as shown in Figure 11.5.1-4. This screen asks the user for information about
rates, labor mixes, and remediation techniques.

* Select optional labor rates and numbers, check boxes, and input associated rates
for checked boxes.

* Click OK to continue or Cancel to terminate.

The rates and mixes on the right side of the window are not optional, thus no check
box is associated with them. For Localized sectors, the form of excavation selected is set to
Mechanical Only. A small dialog box, shown in Figure 11.5.1-5, appears and asks the
user to define how the excavated volume is to be removed.

* Click Sift Off Site, Haul Away, or Sift On Site.
* Click OK.

For discussion of the display of the results, turn to Section 11.6.
11.5.3 Localized Surface Inputs

If the user has selected Localized Surface, indicating the sector contains only a
localized area of surface OEW, the Sector Data input box will be displayed next, as
shown in Figure 11.5.3-1. This window is similar to the window used with dispersed
sector inputs, but with some tailoring for the localized sector characteristics. As with the
Site Data input box, there will be several grayed inputs, some unused by localized
surface, others unused in this version of RPT. For localized surface, eighteen sector inputs
are necessary. These values, along with their ranges and units, are listed in Table 11.5.3-1.
This box will appear one time per Localized Surface sectcr (each time the user selects
Localized Surface in the Sector Type dialog box). The user can exit the code by
selecting Cancel, or continue by clicking OK.

Following the Localized Surface Sector input screen, an activity window will open,
Figure 11.5.1-2. This window contains a list of activities that may occur in the current
sector of interest.

* Click on check box to the left of all activities occurring in sector.
* Click OK to proceed or Cancel to quit.
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This window will also appear one time per Localized Surface Sector in the site. If
the user selects Construction as one of the activities, an input box will appear later in the
run. This box, Figure 11.5.1-3, will prompt the user to input the construction intrusion
depth in feet.

After selecting the activities for the current sector, a cost data screen will be
activated, as shown in Figure 11.5.1-4. This screen asks the user for information about
rates, labor mixes, and remediation techniques.

* Select optional labor rates and numbers check boxes and input associated rates
for checked boxes.

* Click OK to continue or Cancel to terminate.

The rates and mixes on the right side of the window are not optional, thus no check
box is associated with them. For Localized sectors, the form of excavation selected is set to
Mechanical Only. A small dialog box, shown in Figure 11.5.1-5, appears and asks the
user to define how the excavated volume is to be removed.

* Click Sift Off Site, Haul Away, and Sift On Site.
* Click OK.

For discussion of the display of the results, turn to Section 11.6.
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Table 11.5.3-1. Localized Surface Sector Inputs

Parameter Units Range

Sector Area (SA) Sq. Ft. 0 < SA < Site Area
Slope degrees select from categories
Vegetation Density e select from categories
Extraordinary Environmental Costs | $ >0

Line of Sight to contamination Ft. 20

Burning Allowed Yes/No ----

Slippery Yes/No ----

Armed UXO Yes/No -—--

Unarmed UXO Yes/No ----

Explosives and Materials Yes/No ----

Propellants and Pyrotechnics Yes/No o

Non-Controlled Chemical Yes/No —

White Phosphorus Yes/No —

Localized CBR Yes/No

Number of CWM Tents # 20

Snakes Yes/No ----

Bees Yes/No -—--

Poisonous Foliage Yes/No ----

11.5.4 Localized Building Inputs

If the user has selected Localized Building indicating the contamination is to be
removed from a physical structure, the Sector Data input box will be displayed next, as
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seen in Figure 11.5.4-1. This window is similar to the window used with dispersed sector
inputs, but with some tailoring for the localized sector characteristics. As with the Site
Data input box, there will be several grayed inputs, some unused by localized building,
others unused in this version of RPT. For localized building, eighteen sector inputs are
necessary. These values, along with their ranges and units, are listed in Table 11.5.4-1.
This box will appear one time per Localized Building sector (each time the user selects
Localized Building in the Sector Type dialog box). The user can exit the code by
selecting the Cancel button, or continue by clicking on the OK button.




Following the Localized Building Sector input screen, a cost data screen will be

activated, as shown in Figure 11.5.1-5. This screen asks the user for information about
rates, labor mixes, and remediation techniques.

* Select optional labor rates and numbers check boxes and input associated rates
for checked boxes.
* Click OK to continue or Cancel to terminate.

The rates and mixes on the right side of the window are not optional, thus no check
box is associated with them. For Localized sectors, the form of excavation selected is set to
Mechanical Only. A small dialog box , shown in Figure 11.5.1-5, appears and asks the
user to define how the excavated volume is to be removed.

* Selects from Sift Off Site, Haul Away, and Sift On Site.
* Click OK.

For discussion of the display of the results, turn to Section 11.6.
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Figure 11.5.4-1. Localized Building Inputs
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Table 11.5.4-1. Localized Building Sector Inputs

Parameter Units Range

Sector Area (SA) Sq. Ft. 0 < SA < Site Area
Slope degrees Select from categories
Vegetation -——- Select from categories
Extraordinary Environmental Costs | $ >0

Number of Buildings # 20

Burning Allowed Yes/No —

Slippery Yes/No -—--

Armed UXO Yes/No ----

Unarmed UXO Yes/No -e

Explosives and Materials Yes/No —

Propellants and Pyrotechnics Yes/No —

Non-Controlled Chemical Yes/No -—--

White Phosphorus Yes/No e

Localized CBR Yes/No —

Number of CWM Tents # >0

Snakes Yes/No —

Bees Yes/No —

Poisonous Foliage Yes/No ——

11.6 RPT Results

If the user has selected a fixed parameter that lies outside the bounds (clear depth
from zero to ten ft.), a message will appear letting the user know whether the fixed
parameter lies below or above the bounds. Otherwise, the solutions will appear in a
window with the fixed value nested appropriately within the data. This output window will
list clear depth from zero to ten feet in six inch increments, probability of exposure (values
from zero to one), and cost in dollars, as shown in Figure 11.6-1. View these results
graphically by selecting either, Plot Risk or Plot Cost (see Figure 11.6-2, 11.6-3,
respectively). These graphs give the user insight to critical points in the data. The user can
return to the outputs by clicking on OK at the bottom left of the plot window. The user can
also print the results using Print Outputs. Finally, the user can save the results by
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selecting Save Data. When the user is finished with the data, Done returns the user to
the opening screen, where a new run may be started, or the code exited.

RPT Outputs

Figure 11.6-1. Output Screen



Figure 11.6-2. Clear Depth vs. Pexp (Probability of Exposure)
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Figure 11.6-3. Clear Depth vs. Cost
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